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AKVIS SKETCH 27.0 | TURN YOUR PHOTOS INTO PENCIL SKETCHES

AKVIS Sketch converts photos into pencil sketches. It makes your pictures look like real drawings. Now you do not need to
handle a pencil to feel like an artist. All you need to create your original work of art is good taste and AKVIS Sketch!

We propose an efficient method that lets you create realistic color drawings and B&W sketches, imitate the technique of
graphite and color pencil, and even generate the charcoal, pastel, and watercolor effects.

In contrast to standard filters that offer an approximate sketch, AKVIS Sketch comes very close to the hand-drawn works of
a human artist. It lets you create an awesome pencil drawing from any photograph with a mouse click!

The software offers these photo to sketch conversion styles: Classic, Artistic, Maestro, and Multistyle, - each with a
series of presets and with the possibility to create a wide variety of pencil drawings for every taste. Each style has its own
benefits. Play with the settings and enjoy the results!
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AKVIS Sketch has a neat interface to process your images instantly. At first, you can turn the photo into a drawing with the
default settings and then touch up the image by adding color or trying different techniques - from pencil to charcoal or
watercolor. You can adjust all the settings: make the hatching denser or finer, change the pitch angle of strokes, choose the
pencil color, etc.
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The extremely helpful Timeline feature allows you to get semi-processed sketches and variations of your drawing. Watch the
process and choose between the snapshots. Pin the result and continue to play. Then you can compare versions of the
drawing and choose the best one… or two.

The program offers a list of ready-to-use presets which make it easier to work with the software and save you time. You can
create your own presets with your favorite combinations of the photo to drawing parameters.
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Additional Features

Using the software you can also add some unique background effects to your picture! Create a combination of a sketch and a
photo, mixing drawings with real life; imitate motion or add a "time machine effect" by swirling the background. Put an accent
to certain parts of the image by blurring the rest of it in an artistic way.

Personalize your pencil sketch by inserting a signature, a greeting, a logo or a watermark; add a rough texture surface to
your image. Apply a frame to your drawing to create a real work of art.
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The Batch Processing support lets you automatically convert a series of images. You can make comics or cartoons from your
home videos in this way.

For video processing, we also offer a special filter for After Effects and Premiere Pro - AKVIS Sketch Video.
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Field of Application

You can make a pencil portrait as a gift for your relatives and friends, print your sketch on a T-Shirt, decorate a room with a
watercolor drawing or a poster. Designers use the program to quickly bring images to one style for a web-site, an Instagram
account or an advertisement booklet. Experts apply Sketch to demonstrate the features of the architectural styles. Authors
create illustrations for their books with this software.
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Both professionals and home users will be delighted with the ease and effectiveness of the program and excited by the neat
result of the photo-to-sketch conversion. Using AKVIS Sketch is a lot of fun!

On the whole, it's a wonderful tool for those who have always wanted to draw but didn't know how.

 

AKVIS Sketch is available as an independent standalone program and as a plugin to a photo editor. The plugin version is
compatible with AliveColors, Adobe Photoshop, Corel PaintShop Pro, etc. Check the compatibility.

The functionality of the software depends on the license type. Consult the comparison table.

During the trial period you can try all options and choose the license that best fits your needs.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows. We took AKVIS Sketch as an example.
Other AKVIS programs are installed in the same manner.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Sketch, in AliveColors: Effects -> AKVIS –> Sketch.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer. We took AKVIS Sketch as an example. Other AKVIS
programs are installed in the same manner.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-sketch-app.dmg to install the Standalone version

- akvis-sketch-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Sketch application or AKVIS Sketch PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS Sketch app into the folder Applications (or any other place you
like).

To install the Plugin, drag the entire AKVIS Sketch PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> Sketch, in AliveColors: Effects -> AKVIS -> Sketch.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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INSTALLATION ON LINUX

Follow the instructions to install the AKVIS software on a Linux computer.

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using
the uname -srm command.

AKVIS installers are available for several Linux distributions:

► DEB package: Debian/Ubuntu

► RPM package: Red Hat/CentOS/Fedora

► openSUSE

 

We took AKVIS Sketch as an example. Other AKVIS programs are installed in the same manner. Just replace sketch with the
product name (lowercase letters without spaces), for example noisebuster, sketchvideo, etc.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys: 

sudo mkdir -p /usr/share/keyrings
3. Download the key that signed the repository: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
or wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Add the repository to the list where the system looks for packages to install: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Update the list of known packages: 
sudo apt-get update

6. Install AKVIS Sketch 
sudo apt-get install akvis-sketch

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command: 
sudo apt-get upgrade

To remove the program: 
sudo apt-get remove akvis-sketch --autoremove

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository: 

sudo rpm --import https://akvis.com/akvis.asc
3. Add the repository to the system: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Update the package list:

when using the dnf package manager: 
sudo dnf update

when using the yum package manager: 
sudo yum update

5. Install AKVIS Sketch:

when using the dnf package manager: 
sudo dnf install akvis-sketch

when using the yum package manager: 
sudo yum install akvis-sketch

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager: 
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sudo dnf upgrade

when using the yum package manager: 
sudo yum upgrade

8. To remove the program:

when using the dnf package manager: 
sudo dnf remove akvis-sketch

when using the yum package manager: 
sudo yum remove akvis-sketch

 

Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository: 

rpm --import http://akvis.com/akvis.asc
4. Add the repository to the system: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Update the package list: 

zypper ref
6. Install AKVIS Sketch: 

zypper install akvis-sketch
7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates: 
zypper update

To remove the program: 
zypper remove akvis-sketch

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Sketch and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Sketch.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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18

mailto:activate@akvis.com


 

When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WORKSPACE

AKVIS Sketch can work independently as a standalone program as well as a plugin to a photo editor.

Standalone is an independent program. You can run it in the usual way.

Plugin is an add-on for graphics editors, for example for Photoshop, AliveColors, and other compatible programs. To call
the plugin, select it from filters of your image editing program.

The workspace will be arranged according to the editing mode chosen in the Control Panel: Express, Advanced,  or
Presets.

In Express mode, the program's interface is extremely simplified. It has the minimal set of parameters needed for a user to
quickly obtain a satisfactory result.

Workspace of AKVIS Sketch (Express)

In Advanced mode, the full functionality of the program is available: all parameters, under the relevant tabs Sketch,
Background, Decoration, as well as the toolbar.

Note: All features and parameters work in Express mode. Some are hidden and use default values or those of a chosen
preset.
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Workspace of AKVIS Sketch (Advanced)

The Presets button in the top panel allows you to switch to the visual display mode of presets (Presets Gallery).

AKVIS Sketch Workspace, Presets Mode

 

The left part of the program's window is taken by the Image Window with two tabs - Before and After. The Before tab
shows the original image, the After tab shows the resulting pencil sketch. To switch between the tabs and compare the
original and the resulting images, just left-click on any point of the image.

In the upper part of the program's window you can see the Control Panel and the following controls:

The button  opens the home page of AKVIS Sketch.

The button  (only in the standalone version) opens an image for processing. The hot-keys are Ctrl+O  on

Windows, ⌘ +O  on Mac. 

Right mouse click on this button displays the list of recent files. You can change the number of recent documents in the
program's preferences.
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The button  (only in the standalone version) saves image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) prints the image. The hot-keys are Ctrl+P  on Windows, ⌘ +P  on

Mac.
The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series

of images.
The button  imports a list of presets (from the .sketch file).

The button  exports presets (user settings for the image processing). You can save any number of presets to a

separate file with the ending .sketch.
The button  /  shows/hides the guiding lines and the effect area outlines drawn with the tools.

The button  loads saved guiding lines (from the .direction file).

The button  saves the guiding lines to a file with the .direction extension.

The button  cancels the last operation made with lines (guiding lines and background outlines). It is possible to

cancel several operations in a row. The hotkeys are Ctrl+Z , on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys

are Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  starts conversion of the original image into a pencil sketch with the current parameter settings. The

result is shown in the After tab.
The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  calls information about the program.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about Sketch.

 

In the Advanced mode, to the left of the main window there is a Toolbar. Different tools appear depending on the active
tab, Before or After.

 

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is
visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the
visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

Navigator

Additionally, you can move the image in the Image Window with the scroll bars or by holding down the space bar, then
holding down the left mouse button while moving the mouse. The mouse's scroll wheel can move the image up and down, and
holding Ctrl  (⌘  in Mac) – while using the scroll wheel will move the image left and right. Holding Alt  (Option  in Mac) will

scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases.
When you move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field and pressing the button Enter

(Return  in Mac). Frequently used scale coefficients can be found in a drop-down menu.

You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and

Ctrl+-  (⌘ +-  in Mac) to reduce the scale.

 

Under the Navigator there is  the Settings Panel where you can choose the photo-to-sketch conversion Style
(Classic/Artistic/Maestro/Multistyle); and adjust the parameters.
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The Settings Panel has three tabs of settings: Sketch, Background, and Decoration.

On the Sketch tab you can adjust the settings for photo-to-sketch conversion of the selected style.

On the Background tab you can define the area of the picture that should be blurred, or the areas that should remain
in their original state.

On the Decoration tab you can add text to an image, adjust the canvas surface, and apply a frame.

 

In the Presets field you can save the current settings as a preset to use them in the future. The current settings can be
saved, edited, deleted. When you launch the program, it uses the settings of the last used preset.

Attention! The presets save only information about the settings in the Sketch and Decoration tabs (not Background!).

Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them with the cursor. You
can choose where the hints will be shown or hide them in the program's Preferences.
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HOW IT WORKS

AKVIS Sketch converts photos into pencil sketches, the software allows creating realistic color and black and white
drawings. The software can be used independently as a standalone program or as a plugin filter in a photo editor.

In order to turn a photo into a pencil sketch follow the instructions:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you
click on the button  on the Control Panel. You can also drag the required image into the workspace of the

program.

The Standalone edition of AKVIS Sketch supports RAW, JPEG, PNG, BMP, and TIFF file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the key combination Ctrl+O

on Windows or ⌘ +O  on Mac.

Call the AKVIS Sketch plugin select the menu item:

In AliveColors: Effects -> AKVIS -> Sketch;
in Adobe Photoshop: Filter -> AKVIS -> Sketch;
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> Sketch;
in Corel Photo-Paint: Effects -> AKVIS -> Sketch.

The workspace will be arranged according to the interface mode chosen in the Control Panel: Express, Advanced, or
Presets.

AKVIS Sketch Workspace, Advanced Mode

Step 2. Select the photo-to-sketch conversion style - Classic, Artistic, Maestro, or Multistyle; and adjust its
parameters.

The Classic style lets you create color and B&W drawings with well-defined contour lines. A characteristic
feature of this style is its accuracy: the image looks as if it was primarily created by contour lines with the
addition of hatching. Though this mode is versatile and good for many purposes, it is the most suitable for
technical illustration, architectural images, and other pictures where you would like to attain good detail.
The Artistic style is designed to create expressive drawings that look like the handmade work of a real artist. In
this style, it is easy to create both a quick sketch and a carefully drawn and shaded pencil drawing. The main
advantage of this style is the ability to play with hatching and to vary the number of shadings and shadows to
get natural tonal transitions.
The Maestro style is intended to solve artistic tasks. It creates vivid and expressive works of art with masterly
hatching, clear and natural contours, and without excessive detail, less photographic and more like drawings. This
style harmoniously combines exquisite technique and artistry. It is available only for the Deluxe/Business licenses.
The Multistyle is a complex drawing style that allows you to make the effects of pastels, felt-tip pens, oil
pencils, wax crayons, and much more. It is available only for the Deluxe/Business licenses.
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Classic Style Artistic Style

Maestro Style Multistyle

Step 3. Once the program is open, part of the image will be automatically converted to a pencil drawing. The result will
be shown in the quick preview area in the Before tab.

Quick Preview

Step 4. Click on  to convert the photo into a pencil drawing with the new settings.

Note: You can observe the processing in real-time. It's possible to stop photo-to-sketch rendering and save the
semi-processed drawing as a result. To interrupt the process, use the Stop button right to the progress bar.
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Automatic Strokes Guiding Lines Reoriented Strokes

Default Settings

Step 5. Optionally, in the Classic and Maestro styles and in the Multistyle, you can use a special tool that lets you
change the direction of the applied pencil strokes. The Stroke Direction tool  gives you full control over how

hatching is drawn on an image. Using this technique you can achieve a truly realistic drawing with patterns and
textures going in the right direction.

Note: This feature is only available for the Home Deluxe and Business licenses.

Step 6. You can also adjust the settings on the Background tab and use Decoration options: Canvas, Frame, and
Text. Click on the button  to start processing the image.
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Sketch Drawing + Canvas + Text

Step 7. It is possible to save the settings you like as a Preset and use them in the future. A preset contains the
settings of the Sketch and Decoration tabs.

Click on a heart icon /  near the preset name field to add the preset to Favorites or to remove it from this group

of presets.

Learn more about the Sketch Presets.

Step 8. The Timeline feature allows you get variations of your drawing without adjusting the settings. If you like some
semi-processed image more than your final result, click on it to choose. The shot will be shown in the After tab.

If you want to get back to your final result, click on the last shot in the Timeline list.

Note: This feature is only available for the Home Deluxe and Business licenses.

Timeline Shots

You can set the number of the shots in the Preferences dialog box.

Step 9. You can edit the result and put the finishing touches to your drawing with the post-processing tools: Pencil 
, Eraser , and History Brush  in the After tab.

Note: The post-processing tools are only available for the Home Deluxe and Business licenses.

Hint: Use these tools at the final step! If you run the processing  again, the changes made with the tools will

be lost.

Step 10. In the standalone version, you can cut off unwanted areas of the result and improve its composition with the
Crop tool . If you use the plugin, you can do this in your image editor.
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27

https://akvis.com/en/sketch/comparison.php?utm_source=help
https://akvis.com/en/sketch/comparison.php?utm_source=help


Crop Tool

Step 11. In the standalone version, you can also print your result using .

Step 12. Save the processed image.

- If you work with the standalone program:

Click on the button  to open the Save As dialog box. Enter a name for the file, choose the format (TIFF,

BMP, JPEG or PNG) and indicate the target folder.

- If you work with the plugin:

Press the button  to apply the result and close the plugin window. The AKVIS Sketch plugin will close and

the picture will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.

Pencil Sketch
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The check-box "Original Colors" is enabled

 

The check-box "Original Colors" is disabled

SKETCH FROM PHOTO: CLASSIC STYLE

The Classic style in AKVIS Sketch lets you create color and B&W drawings with well-defined contour lines.

A characteristic feature of this style is its accuracy: the image looks as if it was primarily created by contour lines with the
addition of hatching. Though this mode is versatile and good for many purposes, it is the most suitable for technical
illustration, architectural images, and other pictures where you would like to attain good detail.

Pencil Sketch from Photograph: Classic Style in AKVIS Sketch

 

In the Sketch tab you can adjust the parameters for the photo-to-sketch conversion.

There are three parameter fields in the Classic style: Strokes, Edges, and Effects.

Note: You can see the conversion result immediately, as you move the slider, only in the Preview Window. To convert
the whole image, press the button  or click on the After tab.

 

Strokes tab (hatching parameters):

Original Colors. When the check-box is enabled, the program imitates a color pencil drawing using the color range from
the original image. When the check-box is disabled, the program uses the colors selected with the color plates below
(by default black and white).

You can change the saturation of the colors by moving the slider to the right of the check-box. As the value of this
parameter is increased, the colors in the image become more intense and bright.
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Saturation = 0

 

Saturation = 100

 

Angle = 45

 

Angle = 135

 

Angle = 90

 

Stroke Thickness = 5

 

Stroke Thickness = 9

Pencil Color and Background Color. If the Original Colors check-box is disabled, you can use two color plates to set
colors for the pencil strokes and background. Click on the plate and select a color from the standard dialog. Right
mouse click on the plates resets the colors to their default values ​​ (black and white).

Changing Colors

Angle. The parameter sets the pitch angle of the strokes when hatching a uniform area (an area that does not contain
edges and intensity swings). By default, the strokes in such areas are drawn at a 45 degree angle.

Stroke Thickness. This parameter sets the stroke size. If you reduce the value, the strokes on the picture get thinner
and harder, if you increase the value, the strokes get wider and blurred on their edges.

Min Length/Max Length. This parameter sets a range within which the stroke length can vary. There are two sliders
to define the range borders: the left slider sets the minimum length, the right slider sets the maximum length. The
resulting sketch will be made up of strokes that fall within this range.

If you reduce the minimum length, the number of strokes and the detail of the image increase. Visually the drawing
becomes darker. If you increase the value of the minimum length, the number of strokes is reduced (strokes shorter
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Min Length/Max Length = 1/4

 

Min Length/Max Length = 8/16

 

Midtones Intensity = 1

 

Midtones Intensity = 10

 

Midtones Hatching = 1

 

Midtones Hatching = 100

than the set minimum do not get drawn). Visually the image becomes lighter and neater.

If you increase the maximum length, the hatching becomes less uniform. The higher the value of this parameter, the
longer strokes can be drawn on the picture. However, if the value is too high it may worsen the precision of the
hatching.

Midtones Intensity. This parameter defines the intensity of the midtone strokes, as if drawn with different pressure.
As you move the slider to the left, the midtone strokes fade - becoming dim and blurred. As you move the slider to the
right the midtone strokes become thicker and more intensive.

Midtones Hatching. This parameter changes the level of hatching in the midtone areas. If you want to reduce
hatching move the slider to the left.

 

Edges tab (parameters that affect how edges are drawn):

Edge Strength. This is the main parameter used to control edges, by adjusting the intensity of lines and details. At
lower levels there are fewer edges and the level of detail decreases, while at higher values more edges are drawn and
more detail is present.
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Sensitivity = 10 (Edge Width = 15)

 

Sensitivity = 80 (Edge Width = 15)

 

Edge Strength = 0

 

Edge Strength = 50

 

Edge Strength = 100

Edge Tracing. This check-box is used to detect the additional edges between areas that don't have well-defined
transitions in brightness. Its affect can be adjusted further by these two parameters:

Sensitivity. The higher the value of this parameter the more transitions between colors will be retrieved and the
more edges will be defined by lines instead of hatching. If you want to emphasize the edges, increase the value
of this parameter.

Edge Width. This parameter defines the thickness of the outliness. At higher values of this parameter the edges
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Edge Width = 10 (Sensitivity = 70)

 

Edge Width = 60 (Sensitivity = 70)

Edge Width. This parameter defines the thickness of the outliness. At higher values of this parameter the edges
will be drawn by thicker lines.

 

Effects tab:

Watercolor (0-50). The parameter lets you add the watercolor effect to your drawing. By default it is set to 0 which
corresponds to a pencil drawing. As you move the slider to the right (that is, increase the value of the parameter) the
strokes get blurred, contrast and detail get weaker, as if the strokes were drawn on wet paper. The higher the value of
the parameter, the stronger the effect. We recommend to use this parameter together with Coloration to  get  a
watercolor drawing.

Watercolor = 10

Charcoal (0-10). The parameter changes the drawing technique from a fine pencil drawing to charcoal. The higher the
value of the parameter, the more the result looks like a charcoal drawing.
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Charcoal = 7

Coloration (0-100). The effect adds color to a drawing provided that the original image contained color information (if
the image is not grayscale). By default the value is set to 0. When you increase the value, the drawing is mixed with
the original picture.

Coloration = 40

Smudging (0-30). The parameter creates the effect of smearing hatching in midtone areas without affecting the
contour lines of the drawing. This technique looks like a result of rubbing across a drawing with a stump tool, smooth
paper, or a finger. By default it is set to 0 at which there is no smudging effect. At higher values the appearance of
shaded areas changes. Shading becomes similar to soft graphite. It is a fast and simple way to add a soft and blurred
texture to a sketch.
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Smudging = 0

 

Smudging = 30

 

Shadows = 1

 

Shadows = 30

 

Noise = 10

 

Noise = 100

Extra Effects check-box:

Shadows (1-30). The parameter enhances shadows giving your drawing more volume and depth.

Noise (0-100). The parameter adds noise to the image increasing the shading effect.
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Contrast = 0

 

Contrast = 100

Contrast (0-100). The parameter increases the difference between highlights and shadows. Using this setting,
you can get rid of unnecessary details and make the drawing look "cleaner".
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SKETCH FROM PHOTO: ARTISTIC STYLE

The Artistic style in AKVIS Sketch is designed to create expressive drawings that look like the handmade work of a real
artist.

In this style, it is easy to create both a quick sketch and a carefully drawn and shaded pencil drawing. The main advantage
of this style is the ability to play with hatching and to vary the number of shadings and shadows to get natural tonal
transitions. This style requires a good photograph. The best results can be achieved if the original photo was taken in the
right light and has good contrast.

Pencil Sketch from Photograph: Artistic Style in AKVIS Sketch

 

In the Sketch tab you can adjust the parameters for the photo-to-sketch conversion.

The parameters in the Artistic style are grouped in two tabs: Strokes and Effects.

 

Strokes tab (hatching parameters):

Original Colors. When the check-box is enabled, the program creates a color pencil drawing using the color range from
the original image. When the check-box is disabled, the program uses the colors selected with the color plates below.
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Saturation = 0

 

Saturation = 50

Color Drawing

You can change the saturation of the colors by moving the slider to the right of the check-box. As the value of this
parameter is increased, the colors in the image become more intense and bright.

Pencil Color and Background Color. If the Original Colors check-box is disabled, you can use two color plates to set
colors for pencil strokes and background. Click on the plate and select a color from the standard dialog. Right mouse
click on the plates resets the colors to their default values​​ (black and white).
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Angle = 30

 

Angle = 120

 

Min Length/Max Length = 5/25

 

Min Length/Max Length = 20/50

Changing Colors

Angle (0-180). This parameter sets the pitch angle of the strokes. By default, the strokes are drawn at a 45 degree
angle.

Min Length/Max Length (1-100). The parameter sets the full range of the possible stroke lengths. The stroke length
is controlled by the position of two sliders on the same scale: the left slider sets the minimum stroke length while the
right slider controls the maximum stroke length. You will see only the strokes greater than the minimum and shorter than
the maximum settings.

Uniformity (1-50). The parameter defines a type of hatching. In large values ​the light and dark areas of the image are
hatched evenly. Decreasing of the value leads to the selective hatching: the dark areas become more intense and get
more strokes, while on the light areas we see less hatching.
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Uniformity = 15

 

Uniformity = 45

 

Sensitivity = 40

 

Sensitivity = 90

 

Hatching Density = 5

 

Hatching Density = 50

Sensitivity (1-100). The parameter helps to find the edges on the image. The higher the value the more contours will
be drawn. To remove odd lines reduce the value of the parameter.

Hatching Density (1-100). It defines the number of strokes in the image. The higher the value, the less white areas
remain.

Stroke Thickness (10-100). This parameter sets the stroke size. If you reduce the value of the parameter the strokes
on the picture get thinner and harder, if you increase the value the strokes get wider and blurred on their edges.
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Stroke Thickness = 15

 

Stroke Thickness = 65

 

Brightness = 5

 

Brightness = 25

 

Hatching Intensity = 5

 

Hatching Intensity = 50

Brightness (1-100). The parameter adjusts the brightness of the strokes. The lower the value, the lighter the strokes
are. If you increase the value the strokes become more dense and saturated.

Hatching Intensity (1-100). This parameter changes the intensity of the strokes, as if drawn with different pressure
and brightness.

 

Effects tab:

Charcoal (0-10). The parameter changes the drawing technique from a fine pencil drawing to charcoal. The higher the value
of the parameter, the more the result looks like a charcoal drawing.
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Shadows = 1

 

Shadows = 10

 
Charcoal = 7

Shadows (1-30). The parameter enhances shadows giving your drawing more volume and depth.
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Noise = 10

 

Noise = 100

 

Contrast = 0

 

Contrast = 50

 

Hatching (the check-box is disabled)

 

Cross-hatching (the check-box is enabled)

Noise (0-100). The parameter adds noise to the image.

Contrast (0-100). The parameter increases the difference between highlights and shadows. Using this setting, you can get
rid of unnecessary details and make the drawing look "cleaner".

Cross-hatching check-box. It activates the special mode of drawing when the pencil strokes are drawn in different
directions and intersect.

Attention! This option is only available for the Home Deluxe and Business licenses. In the Home version, you can use
this feature only with the watermark. All presets with this option (marked with *) in the Home version can be applied
with the AKVIS watermark. To hide the watermark in the Home version, disable the check-box. It's possible to upgrade
the license to unlock the premium features.
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Rotation Angle = 40

 

Rotation Angle = 90

 

Frequency = 10

 

Frequency = 50

Parameters of cross-hatching:

Rotation Angle (-90 to 90). It defines the angle between the main and additional hatching.

Frequency (5-50). It controls the intensity of the additional hatching.
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Radius = 1, Strength = 10

 

Radius = 5, Strength = 60

The parameters in the Feathering group allow to create a smearing effect, imitate smudging of strokes. Use them to get
smoother, softer, and fuzzier lines.

Radius (1-10). This parameter specifies the size of the areas to be blurred.

Strength (1-100). The parameter specifies the amount of blur. The higher the value, the stronger the feathering
effect.
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Color Drawing
(Check-Box 'Original Colors' is Enabled)

Black and White Drawing
(Check-Box 'Original Colors' is Disabled)

SKETCH FROM PHOTO: MAESTRO STYLE

The Maestro style in AKVIS Sketch is designed to solve artistic tasks. It creates vivid and expressive works of art with
masterly hatching, clear and natural contours, and without excessive detail, less photographic and more like drawings. This
style harmoniously combines exquisite technique and artistry.

Pencil Sketch from Photograph: Maestro Style in AKVIS Sketch

 

Attention! The Maestro style is only available for the Home Deluxe and Business licenses. In the Home version, you
can use this effect only with the watermark. It's possible to upgrade the license to unlock the premium features.

In the Sketch tab, you can adjust the parameters for the photo-to-sketch conversion.

The parameters in the Maestro style are grouped in sections: Strokes, Hatching, Edges, and Effects.

 

Strokes tab:

Original Colors. The option allows you to create a color pencil drawing using the original color range.

You can change the saturation of the colors by moving the slider to the right of the check-box. As the value of this
parameter is increased, the colors in the image become more intense and bright.
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Original Colors (Saturation = 5) Original Colors (Saturation = 80)

Stroke Thickness = 10 Stroke Thickness = 90

If the Original Colors check-box is disabled, you can use two color plates to set colors for the pencil strokes and
background:

Pencil Color and Background Color. Click on the plate and select a color from the standard dialog. Right mouse click on the
plates resets the colors to their default values​​ (black and white).

Changing Pencil & Background Colors

Stroke Thickness. (10-100). The parameter sets the stroke size. If you reduce the value, the pencil strokes get thinner and
harder, if you increase the value, the strokes get wider.
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Min Length/Max Length = 3/10 Min Length/Max Length = 40/50

Angle = 45 Angle = 135

Intensity = 10 Intensity = 100

Min Length/Max Length (2-100). The parameter sets the full range of the possible stroke lengths. In the drawing, only
those strokes will be displayed which are greater than the minimum length (the left slider) and shorter than the maximum
length (the right slider).

 

Hatching tab:

Angle (0-180). The parameter sets the pitch angle of the strokes in a uniform area.

Intensity (0-100). The parameter changes the color intensity of the lines (from pale to saturated).

Hatching Density (1-100). The parameter defines the number of strokes in the image. The higher the value, the less
white areas remain.
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Hatching Density = 1 Hatching Density = 50

Cross-hatching = 0 Cross-hatching = 50

Balance = 5 Balance = 20

Threshold = 10 Threshold = 60

Cross-hatching (0-50). The parameter adjusts the number of strokes drawn in the transverse direction.

Balance (0-100). The parameter adjusts the number and distribution of strokes between the contour lines. At value =
0, the hatching is uniform, increasing the value creates more varied hatching.

Threshold (0-100). The parameter allows removing odd strokes near the edges making the contours more neat. At low
values, more strokes close to the edges are drawn. At high values, only the strokes following in the main direction
remain.

 

Edges tab:
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Contrast Hatching = 20 Contrast Hatching = 50

Contour Detail = 50 Contour Detail = 100

Intensity = 10 Intensity = 100

Contrast Hatching (20-50). The parameter strengthens hatching near the edges.

Contour Detail (0-100). The parameter defines the number of lines at the edges. At low values, the number of
contours is minimal.

Intensity (0-100). The parameter changes the color intensity of the contour lines (from pale to saturated).

 

Effects tab:

Charcoal (0-10). The parameter changes the drawing technique from a fine pencil drawing to charcoal. The higher the value
of the parameter, the more the result looks like a charcoal drawing.
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Charcoal = 8

Watercolor (1-10). The parameter adjusts soft transition between areas creating a watercolor effect.

Watercolor = 6

Mixing (0-100). The parameter allows merging the drawing with the original image. At value = 0, mixing does not occur. When
you increase the value, the colors of the original image begin to appear through the drawing creating a coloration effect.
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Mixing = 40

Extra Effects check-box:

Extra Effects

Shadows (0-30). The parameter enhances shadows giving your drawing more volume and depth.
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Shadows = 0 Shadows = 30

Noise = 0 Noise = 100

Contrast = 0 Contrast = 70

Noise (0-100). The parameter adds noise to the image increasing the shading effect.

Contrast (0-100). The parameter increases the difference between highlights and shadows.
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Black and White Drawing (Check-Box is Disabled) Color Drawing (Check-Box is Enabled)

SKETCH FROM PHOTO: MULTISTYLE

The Multistyle in AKVIS Sketch is designed for those who love bold experiments in graphics. In addition to the pencil
drawings, you can get the effect of pastels, felt-tip pens, oil pencils, wax crayons, and much more.

Drawing from Photo: Multistyle in AKVIS Sketch

 

Attention! The Multistyle is only available for the Home Deluxe and Business licenses. In the Home version, you can
use this effect only with the watermark. It's possible to upgrade the license to unlock the premium features.

In the Sketch tab, you can adjust the parameters for the photo-to-sketch conversion.

Color Drawing. When the check-box is enabled, the program creates a color drawing. When the option is disabled, it makes
a black and white drawing.

Paper Color. Choose the background color in the plate (by default, it's white). Double-click the plate and select a color from
the standard dialog. Click the plate to activate the Eyedropper tool.
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Paper Color (Variant 1) Paper Color (Variant 2)

Hatching Density = 2 Hatching Density = 30

Stroke Thickness = 5 Stroke Thickness = 50

Hatching Density. The number of strokes in the image. The higher the parameter, the less unfilled areas will remain in the
drawing.

Stroke Thickness. The width of lines.

Min/Max Stroke Length. The range of the possible stroke lengths. In the drawing, only those strokes will be displayed which
are greater than the minimum length (the left slider) and shorter than the maximum length (the right slider).
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Min/Max Stroke Length = 1/21 Min/Max Stroke Length = 150/170

Pressure = 10 Pressure = 90

Feather = 5 Feather = 80

Pressure. The pressure of the pencils. Affects the brightness of the colors.

Feather. Looseness of strokes. The thin lines are converted into textured loose strokes with soft edges.

Smoothness. Creates smooth graphic lines imitating the felt-tip pen or marker effect.
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Smoothness = 15 Smoothness = 100

Sensitivity = 5 Sensitivity = 80

Balance = 5 Balance = 90

Sensitivity. The higher the sensitivity level, the more lines are drawn. At low values, some strokes (in the gradient areas)
are clipped.

Balance. Distribution of hatching areas. As the parameter increases, the number of strokes decreases and the amount of
background increases.

Alignment. Changing the hatching pattern. When increasing the parameter, the direction of the strokes becomes less
chaotic.
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Alignment = 1 Alignment = 90

Autostop. If the check-box is enabled, the long calculation will be interrupted automatically.
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TIMELINE

AKVIS Sketch lets you observe the conversion of your photo into a pencil drawing in real time. During the process, the
program creates a list of intermediate shots which represent different stages of conversion — from a semi-processed sketch
to practically finished work. Without changing the settings you can create variations of drawings! You can also quickly
compare the results achieved in different styles.

To display the Timeline at the bottom of the main window, enable the option in the Preferences.

Attention! Using the Timeline significantly slows down the calculation speed. To speed up processing, turn off the Timeline
Shots in the program's preferences.

AKVIS Sketch

Note: Selecting a frame in the Timeline is only available in the Home Deluxe and Business versions. Note that everyone, even
with a Home license, can get a semi-processed image using the Stop button in the progress bar.

 

Start conversion of your photo into a drawing by pressing the button . You will see shots appearing at the bottom of the

window in the course of processing.

You can also take snapshots of your favorite moments with the button  right of the progress bar. When you press it the

drawing in its current state will be added to the list; such manual shots are selected with the blue frame.
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Image Processing

If you press the Stop button in the progress bar, image processing will be interrupted.

Browse the shots in the Timeline to find the image you like most. If you want to get back to your final result, click on the
last shot in the list.

Variants of Drawing

When you change the parameters and re-run image processing, the Timeline will be cleaned up and will start being filled up
with new shots. You can save some of the variants by pinning them with a double click. In the upper corner of the selected
shot appears the icon .

You can switch between the shots, change the settings and re-start processing - the pinned result will remain in the list. It's
possible to unpin it with a double click.

To delete a snapshot, select it in the Timeline and click on .
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Attention! Pinned shots can't be removed with this button! 
Loading a new image into the program removes all shots, including pinned ones.

 

The selected result will be shown in the Image Window under the After tab.

You can modify it with the post-processing tools: , , .

Attention! After using the post-processing tools, switching to another image in the Timeline will result in the loss of
changes made with the tools. You can save the result under a new name and continue working.

 

You can hide/show the Timeline in the program's preferences . If the Timeline Shots option is enabled, you can set the

number of the shots created during image processing.

Program's Preferences
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TOOLS IN AKVIS SKETCH

In AKVIS Sketch, different tools become visible depending on the active tab, Before or After.

Toolbar, Before tab Toolbar, After tab

 

The tools in the program are divided into the groups: pre-processing (Before tab), post-processing (After tab), and
additional tools (Before and After tabs).

Hint:
You can use the buttons  and  to undo/redo the operations made with the tools: , , , , , ,

.

 

Pre-Processing Tools (on the Before tab):

 

Quick Preview . This button switches on/off the preview window, a square frame outlined with the "marching ants"

that instantly displays changes made in the Sketch and Decoration tabs.

You can drag the preview square to any position with the left mouse button or with the double click. This lets you
quickly preview the effect in different areas of the image. To compare the result of automatic conversion with the
original picture, click and keep mouse pressed within the preview area.

Preview Window

You can adjust the preview window size in the program's preferences .

 

Stroke Direction . The tool gives you full control over the strokes. With this technique you can achieve truly

realistic drawings with patterns and textures going in the right direction.

Note: This feature is only available for the advanced licenses (Home Deluxe, Business) in the Classic and
Maestro styles and in the Multistyle.

Add the guiding lines with this tool, and the program will re-make the drawing following the new direction. The changes
will be shown in the preview window. To re-start the image processing, click on the button .

You can adjust the parameters that influence on the effect in a pop-up box that appears when right-clicking in the
image:

Zone of Influence. The parameter changes the width of the area affected by guiding lines. The higher the value,
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Automatic Strokes

 

Guiding Lines

 

Changed Direction

the more hatching will follow the direction of the lines.

Preserve Edges (only in the Classic style). When this check-box is enabled, the effect does not extend to the
outlines.

 

Hint: You can save guiding lines to a .direction file with the  button, and load them with  for further

processing. Loaded lines automatically adapt to the image size.

Effect Area . This tool is only visible if the Sketch & Photo or Sketch & Blur mode is enabled in the Background

tab. It lets you select an area to be converted to a drawing.
No Effect Area . This tool is only visible if the Sketch & Photo mode is enabled in the Background tab. Use it to

select an area that will remain in its original state.
Blur Area . This tool is only visible if the Sketch & Blur mode is enabled in the Background tab. Use it to define

an area that will be blurred.
Eraser . Use this tool to edit the outlines drawn by the pencils.

In the Classic style, when Sketch & Photo / Sketch & Blur is active, the Eraser can operate in one of these modes
and erase:

- all lines (both guiding lines and zone lines of the background effects);
- only area outlines (background effects);
- only guiding lines (direction of the strokes).

You can also adjust the Size of the pencils and eraser in a pop-up box appearing with a right click of the mouse.

 

Post-Processing Tools (on the After tab, for Deluxe/Business):

Attention! The post-processing tools , ,  are only available under the Home Deluxe/Business licenses, on the

After tab. Use them at the final step. If you re-run the image processing , the changes made with the post-

processing tools will be lost!

The tools' options are shown in a pop-up box which appears after right-clicking in the image.

Pencil . This tool lets you draw lines over the result. The color of the pencil is the same as specified in the Sketch

tab.

Size (1-50). The line width which can be drawn with the tool.

Hardness (0-100) defines the blurriness of the tool's edges. The less the value the more blurry the tool's edges
become.

Opacity (1-100). The opacity of the strokes drawn with the pencil. The lower the value, the more transparent
the lines will be.

Smoothing. The check-box eliminates the irregularity of the line. The strokes drawn with the tool get smoothed
out.

Refined Lines. The check-box changes the appearance of the pencil strokes. When this option is enabled, the
ends of the lines become thinner, the drawing looks more refined and elegant.
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Sketch Effect

 

Using Pencil Tool

 

Sketch Effect

 

Using Eraser

Eraser  lets you erase the pencil strokes, both generated with the program and drawn manually with the tool ,

using the background color selected in the Sketch tab.

Size (1-1000). The width of the transparent line which the eraser leaves behind.

Hardness (0-100). The amount of blurriness of the brush's edge. As the value of this parameter increases the
edge of the brush becomes harder. Near 100% the border between erased and unerased areas will be more
distinct; at lower values the boundary between these areas will be smoother.

Strength (1-100). The amount of influence on an image. As this parameter's value is increased, the degree of
transparency left by the brush increases.

History Brush  lets you fade the drawing effect and restore the image to its original state.

The tool's parameters:

Restore to Original. If the check-box is enabled, the tool edits all changes, weakening the drawing effect, as
well as the result of the post-processing tools. If the check-box is disabled, the brush changes only strokes
drawn with the pencil  but does not affect the result of the photo to sketch conversion.

Size (1-1000). The width of a line made by the brush.

Hardness (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool's edges
become. At value 100% the border between the brush's edges and the background is very distinct; at lower
values the transition between these areas is smoother.

Strength (1-100). The degree of restoration to the original state. At lower values there will be less restoration
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Sketch Effect

 

Using History Brush

and more blending with the effect; at value 100% the original image will be restored more completely.

 

Crop  (in the standalone version) lets you cut off unwanted areas in the image. The tool is useful when you want

to improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and
contrariwise.

You can change the crop area by dragging the sides and the angles of the bounding frame.

To apply the result and remove the areas outside the frame, press OK or use Enter . To cancel the operation and exit

the tool, press Cancel or use the Esc -key. To restore the original area keeping the tool active, press Reset button.

Crop Image

Adjust the crop parameters:

You can choose the size of the crop rectangle using the Ratio or Fixed Size options.

If the External Area check-box is enabled, you can change the color and opacity of the outer parts.
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Additional Tools (available on both tabs, for all licenses):

Hand  lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click on

the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired
direction. The hot-key is H .

Double-clicking on the tool's icon  on the Toolbar makes the image fit the window.

Zoom  lets you change the image's scale. To zoom in left click on the image. To zoom out left click with Alt  on the

image. The hot-key is Z .

Double-clicking on the tool's icon  makes the image scale to 100% (actual size).
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BACKGROUND EFFECTS

Use the Background tab to process the converted image further. It is possible to imitate a blend of the original photo and
the drawing or to blur some parts of the image.

This tab can be used to put an accent on a certain fragment of the image or to enliven a picture by adding motion. For
example, it is possible to separate the background from the object (a plane or a bird in the sky; a soft toy on a sofa; a vase
with fruit, etc.) or to single out one object among several equivalent objects (one person in a group photo, the most
beautiful flower in a garden image, etc.) and many other things.

The Background tab offers three modes: Sketch, Sketch & Photo, Sketch & Blur.

 

Sketch

In this mode, the Background tab has no influence on the image. In other words, the additional background effects are
disabled. It is the default mode in which the first tab's settings, controlling the photo-to-sketch conversion, only work.

Sketch Mode

To use the other two modes you need to specify areas with the special tools.

 

Sketch & Photo

In this mode, you can get a blend of a drawing and a picture - only the defined parts of the image will be converted into a
drawing.

Sketch & Photo Mode

When this mode is enabled, the special tools appear in the Toolbar, that will help you to define, which areas will be
converted to a drawing, and which not.

AKVIS Sketch

67

#sketch
#sketchphoto
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Grayscale is disabled: Original Image

 
Grayscale is enabled: B&W Image

Effect Area . Use the blue pencil to draw an outline within the areas that will be converted to a drawing in

accordance with the parameters of the Sketch tab.
No Effect Area . Use the red pencil to outline the parts of the image that will remain in their original state.

Eraser . Use this tool to edit the outlines drawn by the pencils. When Sketch & Photo (or Sketch & Blur) is

active, the tool can operate in three different modes:

- Erase all lines (both guiding lines and zone lines of the background effects);
- Erase only guiding lines (direction of the strokes);
- Erase only zone lines (background effects).

Adjust the Size of the tools in a pop-up box that appears when right-clicking in the image.

Effect Area (blue): Pencil Drawing
No Effect Area (red): Original Photo

Note: If only blue lines or no outlines are drawn, the entire image will be a drawing. If only red lines are used, the image will
be restored to its original state.

Attention! During processing you will see that the whole image (regardless of the drawn lines) will be converting into a
drawing. Don't worry. It's only one of the processing steps, not an error. In the next step the program will take
into consideration the background effects lines and settings.

Grayscale. This option works only for black and white drawings. When the check-box is enabled, the areas marked with red
(or green, in the 3rd mode) are converted to grayscale. Use this option to get the entire image in black and white, not only
the "drawing" part.

 

Sketch & Blur

In this mode, it is possible to blur the selected parts of the image. In the Toolbar you will find these tools: Effect Area ,

Eraser , and the Blur Area . The latter is used to define the areas that must be blurred.

Select a Blur Method that will be used in image processing and adjust the parameters.

Gaussian Blur. When this method is selected, the program recalculates the color components (red, blue, and green)
for every point of the image, taking into account the corresponding values of the neighbouring points; as a result the
points change their colors. The calculation is based on the Gaussian distribution and is named after it. In this way the
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Radius = 3

 

Radius = 8

values of the color components are averaged and the contrast between them weakens. The sharp borders are blurred
without general lightening or darkening. The image gets dim, "cloudy".

Gaussian Blur

The Radius parameter adjusts the strength of the effect application. It defines to what extent a point influences on
the neighbouring points when its color components are being recalculated. At low values only the adjacent points will
be changed. Every point will undergo a slight change, but the blurring will be visible. The higher the value of the
parameter, the wider is the influence area of every point. The image will get more blurred till it becomes completely
indiscernible and looks like one stain (at high values of the parameter).

Motion Blur. This blur method imitates the straight line motion of a camera.

Motion Blur

Parameters:

Angle. This parameter sets the inclination angle of the line, along which the effect will expand to the image. The

AKVIS Sketch

69



 

Angle = 45, Reach = 20

 

Angle = 135, Reach = 20

 

Reach = 10, Angle = 135

 

Reach = 30, Angle = 135

values of the parameter vary between 0 and 180 degrees. At exactly these values the blurring will be horizontal. At
value = 90 the blurring will be vertical.

Reach. This parameter defines the zone of effect application in pixels (relative to every point of the image).

Radial Blur. This method imitates motion, too. There are two kinds of motion:

Spin. This mode imitates the effect of a camera rotating around the central point of the image, which results in circular
blurring.

Radial Spin Blur

Zoom. This mode creates blurring directed away from the center.
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Amount = 20, Spin Blur

 

Amount = 40, Spin Blur

 

Amount = 20, Zoom Blur

 

Amount = 50, Zoom Blur

Radial Zoom Blur

In the Blur Center section, you can determine the position of the central blur point. To set the position move the
white marker. The current coordinates are shown in the fields X and Y.

The rotation angle in Spin mode and the effect application area in Zoom mode are adjusted with the Amount
parameter.

In the Sketch & Blur mode, you can also choose one of the following methods of the result image generation - Blur Order:

Drawing on Blur. In this case the blue areas are converted to a drawing, while the green areas are first blurred with
the settings of the selected Blur Method, and only than are converted to a drawing in accordance with the settings of
the Sketch tab.
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Gaussian Blur

 

Motion Blur

 

Radial Spin Blur

 

Radial Zoom Blur

 

Gaussian Blur

 

Motion Blur

Blur Photo. In this mode the blue areas are converted to a drawing, while the green areas are only blurred, not
converted. The result image is a blend of the blurred photo and the sketch.
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Radial Spin Blur

 

Radial Zoom Blur

 

Gaussian Blur

 

Motion Blur

 

Radial Spin Blur

 

Radial Zoom Blur

In this mode the Grayscale check-box can be applied.

Blur Sketch. In this mode the whole image is transformed into a drawing, but the green areas are also blurred.
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ADD A FRAME TO A PENCIL DRAWING

In AKVIS Sketch you can also add a frame to your sketch drawing to create a real work of art.

In the Decoration group switch to the Frame tab, enable the check-box of the same title, and choose the frame style and
texture.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Adding Frame

 

You can apply these frames to your sketch:

Classic Frame
Pattern Frame
Strokes
Vignette
Passe-Partout
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ADD TEXT OR WATERMARK TO YOUR DRAWING

You can personalize your work of art by adding a signature to your pencil drawing, create a postcard by placing greeting text,
insert a logo or a watermark to your image to protect it.

Select Decoration -> Text tab. By default, the parameters of the tab are disabled; for the inscription to appear on the
image, enable one of the modes - either Text or Image.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Painting with Inscription

You can add any text or image.

Adjust the text/watermak settings.
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IMITATE SKETCH DRAWING ON A CANVAS

AKVIS Sketch not only offers photo-to-sketch conversion, it also lets you add a textured surface to a picture imitating a
drawing on a canvas, corrugated paper, brick wall or anything else.

To use this effect, adjust the settings in the Decoration group in the Canvas tab.

By default the parameters of the tab are disabled and the sketch comes out as if drawn on plain paper. To activate the
parameters of the Canvas tab, select the check-box Use Canvas.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Sketch on a Textured Paper

You can choose a texture from Library -> Surface or load your own sample: Library -> Custom…

Adjust the canvas settings.
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WORKING WITH PRESETS

AKVIS Sketch includes ready to use presets. When moving a cursor over an AKVIS preset in the drop-down list, the sample
appears in the small window on the left side of the list. You can modify the settings of the preset to achieve the desired
result.

The program lets you create your own presets by saving your favorite combinations of the parameters. Enter a name for your
preset into the field and press the Save button. The next time you start the program the last settings will be used by
default.

To return to the initial settings of the selected preset, click on Reset.

To delete a preset, choose it from the drop-down list and press Delete. The AKVIS built-in presets cannot be removed.

To convert a photo into a drawing using a preset, choose it from the list and press .

 

Next to the preset name field there is a heart icon / . Click on it to add the selected preset to Favorites or to remove

it from this group of presets.

 

Presets Gallery

Click on the Presets button in the top panel to switch to the visual display mode of presets with the real-time approximate
preview.
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Presets Gallery

You will see a list of presets sorted alphabetically (AKVIS presets) or by creation date (user presets). When an image is
loaded into the program, preset thumbnails are generated.

Click on a thumbnail to select the preset. Double-click on the thumbnail starts processing the entire image.

Double-click on the name of the user preset to rename it. The AKVIS built-in presets cannot be renamed.

Use these buttons to change the display of presets:

 - to show AKVIS Presets;

 - to show User Presets;

 - to show presets marked as Favorites.

Presets thumbnails can be arranged in two ways:

 - as a vertical list;

 - filling in the entire program area.

The preset control buttons are duplicated by the context menu commands:

 Add to Favorites /  Remove from Favorites;

 Rename Preset (only for user presets);

 Move Up (only for user presets);

 Move Down (only for user presets);

 Delete Preset (only for user presets);

 Show Parameters.
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You can save your presets to a .sketch file with . To load presets from the file use .

Read more how to import and export user presets.

Note: You should import and export presets for each style separately.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box. It looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. This parameter defines the way the image is scaled in the Image Window after opening. The
parameter can take one of two values:
- image scaling Fit to view. The scale adjusts so that the image will be completely visible in the Image Window;
- if the option 100% is checked, image doesn’t scale. Generally, when the scale = 100%, only part of the image will be
visible.
Preview Window Size. Choose the desired value for the size of the Preview Window. It can have values from 200 х 
200 to 1,000 х 1,000 px. By default the parameter’s value = 700, that is the quick preview area has a proportion 700 х 
700 px.
Processing Size Limit. This parameter accelerates image processing by temporary reducing the size of the image to
be processed. When the file size (in megapixels) does not exceed the defined value, the image is processed in a usual
way. If the loaded file is larger, the program will reduce the image, process it and enlarge again to the initial size. 
Note that the processing result will be different for a different value of the parameter.
Recent Files (available only in the standalone version). The parameter sets the number of recent files, sorted by time,
displayed in the list by right-clicking on  (maximum: 30 files).

Show Processing Size check-box. When the check-box is enabled, the working size of the processed photo is
displayed in the Before/After tabs. Enabling/disabling the parameter does not affect the size of the saved result.
Timeline Shots. The option enables the Timeline feature and the parameter changes the number of the shots created
during image processing. Selecting a frame in the Timeline is only available for Home Deluxe and Business licenses. 
Note that this feature significantly slows down the processing speed.
Hints. When you hover over parameters and buttons with the cursor you can see a brief description of them in the
Hints field. You can choose how the hints will be shown:

- Under Image Window. It shows the hints in the main window, under the image. This mode is useful if there is
not enough space by height to display this field under the settings;
- Under Settings Panel. Select this to show hints at the bottom of the right part, under the settings;
- Hide. Use this option if you do not need the hints.

The Same Loading And Saving Directory. When the check-box is enabled, the program uses the same folder in the
open and save dialogs. By default, this option is inactive (different paths are used for loading and saving files).
Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is enabled
the panel is always visible. Uncheck the option to unlock the panel, and you will be able to hide/show it by clicking on
the small triangle button (in the middle of the panel). The minimized panel will be shown when moving the cursor over it.

To save changes made in the Preferences window press OK.

If you need, click on the button Default to come back the default settings.
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BATCH PROCESSING

AKVIS Sketch supports batch processing that lets you automatically process a series of images.

Batch processing is useful when dealing with a lot of photos taken under the same conditions with identical camera settings
or when creating a video (to process all frames automatically). It saves you time and effort.

 

If you use the standalone version of AKVIS Sketch, read the instructions here.

If you use the Sketch plugin in Photoshop, use this tutorial.
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BATCH PROCESSING WITH PHOTOSHOP PLUGIN

The AKVIS plugins support the automation feature in Adobe Photoshop.

Batch processing is very useful and time saving when you have to apply the effects to a number of photos. This method
applies the same settings to a folder full of images.

Even if you have never used batch processing you will find no difficulties in understanding it. First you create an Action in
Photoshop and then apply it to a photo folder.

Follow the instructions:

Step 1. Create two new folders, for example: "source-files" and "result-files". Place original images into the "source-
files" folder. The results will be saved in the "result-files" folder.
Step 2. Open one of the original images in Adobe Photoshop. We will use this photo to adjust the plugin's settings and
create an action.

Step 3. In the Actions palette click Create New Set button. In the dialog window give a name for a new set of
actions, for example, "AKVIS".

If you already have a special set for the AKVIS actions, you can just choose it.

Actions Palette

Step 4. Press Create New Action and give a name for it, for example, "Oil".
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New Action

Press the Record button, and the recording of the action will immediately start.

Step 5. Call the plugin and adjust its parameters.
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Step 6. Press the button . The plug-in window will close and the effect will be applied to the image. In the Actions

palette, in your new action, you will see a new line with the plugin's name.

Step 7. Remember that the action is still being recorded. Now, you should save the image. Choose Save As in the File
menu and save the image into the destination folder.
Step 8. Stop the action recording by pressing Stop playing/recording at the bottom of the Actions palette.

Step 9. Delete the file that you have just saved.
Step 10. The action is created and you can proceed to batch processing of the photos.

In the File menu of the editor choose Automate -> Batch.

Step 11. In the Batch dialog window and set the parameters:
In the Set drop-down list choose "AKVIS" and the new action.
In the Source option set Folder. Press the Choose… button and select "source-files".
As the Open command was not recorded in the action, the Override Action "Open" Commands check-box
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should be deactivated.
For Destination select Folder, then press the Choose… button and select "result-files".
Activate Override Action "Save as" Commands check-box.
In the File Naming section you can create the filenames structure for the resulted images. If you do not want to
change the names, in the first combo-box choose document name, and in the second - extension.

Step 12. Press OK to start processing. Photoshop will apply the AKVIS plugin to all photos in the "source-files" folder,
one by one, and will save them to the "result-files" folder.
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PRINT IMAGES IN AKVIS SKETCH

In the standalone version of AKVIS Sketch you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Sketch

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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Original Image

 

Result

USING SMUDGING TECHNIQUE ON A SKETCH

Smudging is the next step after mastering the technique of line drawing. When an artist uses this shading technique he can
achieve subtle gradations in shade and tone, making it possible to give an image volume and expressiveness. This tutorial
shows how such a technique can add a beautiful effect to a portrait when using AKVIS Sketch.

Step 1. Open an image in AKVIS Sketch.

Original Image

Step 2. The preview window shows the photo processed with the default settings.

To get rid of unnecessary detail reduce Edge Strength from 80 to 45. You make the strokes more expressive by
changing Charcoal to 2. Then increase the value of Smudging to 10. If you wish, switch to Advanced mode and
change some of the parameters there.
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AKVIS Default Settings

 

After Changing Parameters in "Express" Mode

Step 3. In some places contour lines have been broken by hatching. To restore the contour lines and change the
direction of adjacent strokes, use the Stroke Direction  tool.

Guiding Lines

Press  to process the entire image. A great result!
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The Effect of the "Stroke Direction" Tool

Step 4. The only thing left is to remove the small defects around the shoulder:

Small Defects After Processing

To do this, switch to the Background, select Sketch and Blur from the drop-down list, use Drawing on Blur, and
choose Gaussian Blur for the blur method.

Draw over the area with defects using the green pencil . This area will be blurred before being converted to a

drawing. Use the blue pencil  to limit the scope of that area.
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Marked Areas in "Sketch and Blur" Mode

Press  to start processing.

Result After Blurring

Step 5. Save the image .
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Portrait of a Girl
(click to open a full size version of the image)
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SHINY APPLE: AN ARTIST'S TOUCH

When creating a high-quality drawing, it is necessary not only to pay attention to lines and details, but also to how textures
are represented. The Stroke Direction tool and other features of AKVIS Sketch can convey the structure of an object as if
it were drawn by a real artist.

Step 1. Open the image in the graphics editor with the menu command File -> Open.

Original Photo

Step 2. Call the plugin Filter -> AKVIS -> Sketch. In the preview window you can see how a part of the photo would
be processed with the AKVIS Default preset. To process the entire image press the  button.
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Result Using Default Settings

Step 3. Adjust the settings to make strokes clearer and more expressive:

Charcoal = 2;
Min Length/Max Length = 5/13;
Midtones Intensity = 6.

Process the image again:

Result With New Stroke Settings

Step 4. The uniform strokes across the image do not look very realistic. To make the strokes follow the contours of the
object, activate the  tool and draw a few guiding lines. Change the parameter Zone of Influence to 76, so that

more strokes will follow the guiding lines.
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Guiding Lines

Press the  button. The result differs from the one received in Step 3:

Changing the Direction of Strokes

Step 5. Note that small defects were formed over the smooth surface of the apple where there were spots.

It's possible to make these defects less noticeable using the features of the program.

The first method: deactivate the Preserve Edges check-box. The strokes reorient themselves in a general direction,
but now the image's borders are weaker.
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After "Preserve Edges" Was Deactivated

The second method: use the blur tools. Usually these are used to create an effect, but here they can be used to
correct a defect.

Switch to the Background tab and choose Sketch & Blur from the drop-down menu, the processing method Drawing
on Blur, and the Gaussian blurring method.

Use the blue pencil (Effect Area Tool)  to indicate the area that will not be blurred. Use the green pencil (Blur Area

Tool)  to mark the area with defects - they will be blurred before the photo is converted into a drawing.

Area That Will Be Blurred

Start processing by pressing the  button.
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Blurring Was Used To Remove Defects

Step 6. Press the  button, to apply the changes to the image. The plugin's window closes, and the processed

image will appear in the graphics editor.

Finally, the image needs to be brighter. To do this, make a copy of the image by choosing Layer -> Duplicate Layer.
Apply the Linear Burn blend mode to the top layer in the Layers palette, set the Opacity to 30% and choose the
command Layer -> Flatten Image.

Result
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Source image: photo of a hotel

 

Result: color sketch

CONVERT A PHOTO TO A COLOR SKETCH

By default AKVIS Sketch converts any image into a black and white pencil sketch. But if the original photo is colored, it is
possible to add color from the original image to the pencil drawing.

We use the Sketch plugin in this tutorial, but you can take the standalone edition and use the same parameters to achive
this result.

Step 1. Open a color photo in your photo editor.

Step 2. Call the plug-in AKVIS Sketch:

In AliveColors: Effects -> AKVIS -> Sketch;
in Adobe Photoshop: Filter -> AKVIS -> Sketch;
in Corel Paint Shop Pro: Effects -> Plugins -> AKVIS -> Sketch;
in Corel Photo-Paint: Effects -> AKVIS -> Sketch.

Step 3. Press the button  to convert the photo into a pencil sketch with the default settings.
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Step 4. Reduce the value of the parameter Stroke Thickness to make the lines thinner and harder.

Reduce the value of the parameter Midtones Intensity to reduce the intensity of hatching in the uniform light areas of
the picture (i.e. the sky).
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Step 5. Let's add color to our pencil drawing by increasing the value of the parameter Coloration to 70.

Also you can use the Color Pencil option in the Strokes section. The result will differ, the option imitates color
strokes.

It's possibile to use both ways to add color to pencil drawing (Coloration and Color Pencil).

Step 6. Press the button  to apply the result to the image and close the program.
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Source photo of a tulip

 

Black and white pencil drawing

PENCIL SKETCH FROM PHOTO: A TULIP DRAWING

For the first illustration of how AKVIS Sketch works we have chosen a simple picture: a flower in the foreground and a
blurred background without any clear details.

We use the Sketch plugin in this tutorial, but you can take the standalone edition and use the same parameters to achive
this result.

Step 1. Open the image with your photo editor and call the plug-in AKVIS Sketch. Press the button  to process

the photo with the default settings. The image will turn into a pencil sketch.

Step 2. Reduce the value of the parameter Stroke Thickness to make the strokes thinner and harder.

As you change the value of a parameter press the button  to process the photo with the new settings and see

what influence the adjusted parameter has on the drawing.
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Step 3. The parameter Angle sets the pitch angle of the strokes when hatching a uniform area. On this picture the
background is uniform and we can notice that the strokes are drawn 45 degree to the right. Let's change the pitch
angle in such a way that the strokes in the background had the same angle as the tulip. We set the parameter Angle
to 135.

Step 4. Now reduce the value of the parameter Midtones Intensity to 1 to make the background less bright.

Here is our black and white pencil drawing:

AKVIS Sketch

102



Step 5. Press the button  to apply the conversion result to the image and close the program.
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
original quality of compressed images. The software is available free of charge. It is a must for both home users and
professionals. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of anyGouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any
picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…
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AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…

 

AKVIS NatureArt — Bring Nature to Your Photos
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AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…

 

AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…
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AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…
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AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…

 

AKVIS Sketch — Turn Your Photos into Pencil Sketches
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AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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